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Software License Agreement
BY USING THIS PACKAGE, YOU ACCEPT ALL THE TERMS AND CONDITIONS OF THIS LICENSE
AGREEMENT. If you do not agree to the terms of this Agreement, you should promptly return this package
unopened to the place where you obtained it for a full refund.
Licenses:  ColorDesk Inc. ("ColorDesk") grants you a license to use the enclosed application software,
whether on compact disc or other diskettes ("Disks"), including the related documentation (the "Software")
in accordance with the terms of this License. You own the Disk(s) on which the Software is recorded but
ColorDesk and/or ColorDesk's Licensor(s) retain title to the Software.
You May: (1) use the Software on any single computer provided that the Software is in use on only one
computer at a time. The Software is "in use" on a computer when it is loaded into the temporary memory
(i.e., RAM) or installed into the permanent memory (i.e., hard disk) of that computer. (2) make a single
copy of the Software solely for backup purposes. (3) use the Software in a networked environment so long
as each computer in such environment is the subject of a separate license for the Software; however, you
may not electronically transmit the Software from one computer to another over the network. (4)
permanently transfer your rights under this Agreement to a third party by providing to such party this
Agreement, the Software, and all accompanying written materials, provided that you retain no copies of the
Software or written materials and that the other party agrees to the terms of this License Agreement.
You May Not:  (1) make (or allow anyone else to make) any form of copy, whether digital, printed,
photographic or otherwise, of any of the images in the Software, except insofar as such images may be
incorporated by you into on-screen or printed material. (2) place (or allow anyone else to place) any of the
images in the Software on an electronic bulletin board or other form of on-line service. (3) use (or allow
anyone else to use) any of the images in the Software in any matter which is in any way defamatory of any
person or business entity in any such image, or which implies any form of endorsement by ColorDesk, its
suppliers, its licensors, or any individual or entity depicted in these images. (4) reverse engineer,
decompile or disassemble the Software or otherwise reduce the Software to a human-readable form.  (5)
modify, adopt, translate, rent, lease, loan or create derivative works from the Software. (6) export the
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Software in any form in violation of the United States Export Administration Act or the laws and regulations
of any foreign jurisdiction.
Terms:  This License shall continue for as long as you use the software, except that it will terminate if you
fail to comply with any term or condition of this Agreement. Upon such termination, or in order for you to
terminate the Agreement, you agree to destroy the original and any copies of the Software. The Limitation
of Warranties and Liability set out below shall continue in force even after any termination.
Warranty:  ColorDesk warrants to you that the Disk on which the Software is recorded will be free from
defects in materials and workmanship for a period of ninety (90) days from your date of receipt. If such a
defect occurs, return it to the address below and ColorDesk will replace it for free.
Limitation of Warranties and Liability:   Except for the express warranty above, THE SOFTWARE IS
PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND. COLORDESK AND ITS LICENSORS MAKE
NO OTHER REPRESENTATIONS OR WARRANTIES AS TO THE SOFTWARE, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE. ColorDesk's aggregate liability, including that of
ColorDesk's dealers, suppliers and licensors, shall not exceed the amount paid by you for the Software. IN
NO EVENT WILL COLORDESK, ITS LICENSORS OR ITS DEVELOPERS, DIRECTORS, OFFICERS,
EMPLOYEES OR AFFILIATES BE LIABLE FOR ANY CONSEQUENTIAL, INCIDENTAL OR INDIRECT
DAMAGES (INCLUDING BUT NOT LIMITED TO DAMAGES FOR LOSS OF BUSINESS PROFITS,
BUSINESS INTERRUPTION AND LOSS OF BUSINESS INFORMATION) ARISING FROM THE USE OF
OR INABILITY TO USE THE SOFTWARE OR ACCOMPANYING WRITTEN MATERIALS. Some states do
not allow the exclusion or limitation of liability for consequential or incidental damages, so the above
limitation may not apply to you.
Restricted Rights:   Use, duplication or disclosure by the Government is subject to restrictions as set forth
in subdivision (c)(1)(ii) of the Rights in Technical Data and Computer Software clause of DFARS 252.227-
7013.
General:  You acknowledge that you have read this Agreement and understand that it is the complete and
exclusive statement of your agreement with ColorDesk Inc. This Agreement will be governed by the laws of
the State of California.

Notice
All rights reserved.  No part of this publication may be reproduced, stored in a retrieval system, or
transmitted, in any form or by any means, electronic, mechanical, photocopied, recorded, or otherwise,
without prior written permission from ColorDesk, Inc.

Trademarks
ColorDesk Photo, ColorDesk and the ColorDesk logo are trademarks of ColorDesk, Inc.  EfiColor is a
trademark of Electronics for Imaging, Inc.  All other product names, company names and brand names are
trademarks or registered tradenames of their respective companies.

Introduction

Congratulations on your purchase of ColorDesk Photo 1.0! High quality, color photo
editing and printing is now within the reach of your desktop. ColorDesk Photo allows
you to easily add sharp, color photos to your reports, newsletters, flyers, presentations,
brochures and other documents. Whether you're using a hand-held scanner and ink jet
printer at home, a flatbed scanner, Photo CD and high-end printer at work, or your local
print shop's equipment, ColorDesk Photo gives you the precise, professional results
you want. And its easier than using your favorite word processor!

If you haven't already taken the time, please be sure to fill out and send in your product
registration card today. This information allows us to provide you with the best technical
support while keeping you informed of valuable product and upgrade information.

Product Overview
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ColorDesk Photo is a complete desktop color photo publishing system which provides
a simple way to capture color images on your Microsoft Windows PC, easily add them
to your documents and print them with high quality results on almost any color printer.
With no expert knowledge of the color publishing process required, anyone can now
edit and print professional-looking, color documents utilizing advanced technology
previously available only to the pre-press industry.

ColorDesk Photo provides you with many of the capabilities of a photo touch-up lab.
Rotation, cropping, resizing and flipping can all be done at the click of a button. Tools
for dust and scratch removal and image sharpening give you the ability to overcome
imperfections in the original photograph. Color enhancement tools allow you to adjust
exposure, color balance, highlights, shadows, contrast and more.

In short, you can do the work that is normally done by a skilled graphic arts technician
with a complex color separation scanner. But you can do it on your PC using simple
editing tools.

More importantly, you don't have to know anything about color processing or printing.
ColorDesk Photo makes the process intuitive and easy while handling much of the
complexity itself.
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At the heart of ColorDesk Photo is the ColorDesk Color Matching System. An
enhanced version of the industry-proven, EfiColor Color Management System, the
system provides precise color matching across all your desktop color peripherals.
Images and photographs from your scanner, Photo CD, digital camera or any image
bank are accurately reproduced across all supported displays and printers.

The results are WYSIWYG in its truest form – WHAT YOU SEE on your screen IS
exactly WHAT YOU GET from your printer. No more “print-compare-edit-reprint” trial
and error cycles, wasting paper, ink and your precious time. If you like what you see on
the screen, you'll like what you get from the printer.

ColorDesk Photo also provides support for OLE 2.0 allowing you to access all these
capabilities without ever leaving your favorite Windows application such as Microsoft
Word, PowerPoint or WordPerfect.
You can even make changes to your image and have it reflected in all documents
containing a link to it.

Installing ColorDesk Photo

Requirements:

To successfully run ColorDesk Photo, you should have the following:
-  IBM-compatible PC with 386 CPU or higher
-  4 MB of RAM (8 MB recommended)
-  5 MB disk space
-  Graphic display system capable of at least 256 colors
-  Microsoft Windows 3.1 or higher

To Install
Installing ColorDesk Photo is easy.  Just follow these steps:
1.   Run Microsoft Windows.
2.   Insert diskette #1 in floppy disk drive A.
3.   In Program Manager, select the Run command from the File
      menu.
4.   Type a:setup and press OK.

During installation, you will be prompted for the directory in which to install ColorDesk
Photo. Press ENTER to use the default directory, or type in your desired directory. The
installation program will then prompt you to insert the next diskette into the disk drive.

When the installation is completed, the ColorDesk Photo application

icon appears in the ColorDesk Program Group .

To verify the installation, double-click the ColorDesk Photo icon to start the application.
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ColorDesk Setup

To enable accurate color matching, click the ColorDesk button
to specify the peripheral devices you are using: scanner,
monitor, printer. Change these settings whenever you want to
specify a different device.

1. Click the ColorDesk button.

2. For each device category, click the Down Arrow to display the list of periphals. There
may be more than one listing for any given brand of peripheral. For printers, the
settings include different paper types. Make sure to choose your exact brand and
model.

3. Select the scanner, monitor and printer you are working with. If your periphal is not
listed, select “other”.

4. Click OK.

5. In order to achieve accurate color matching, it is important to make sure that the
driver settings for your scanner and printer are set correctly. You can find the correct
settings for your scanner and printer in the on-line help, under Driver Settings. To check
the current printer settings and modify them if necessary, select Print Setup from the
File menu, and click the Options button. To check the current scanner settings and
modify them if necessary, select Acquire from the File menu.

Note
If the paper you are using is not supported, choose a setting with a paper type of the
same family - coated, glossy, plain, etc.



777

Opening an Image

ColorDesk Photo enables you to open image files created by different input sources, in
a variety of image file formats. You can open multiple images at the same time.

To Scan an Image
Use the Select Source option in the File menu to specify the scanner type, and then
click the Scan button   .  To achieve good color matching, make sure you have
specified the correct scanner type, as described on the previous page.

To Load a CD Image
Click the Load CD button   . If your CD is a Photo CD, a standard Photo CD browser
with thumbnail images appears. Otherwise, a standard Windows File Open dialog box
appears, describing your CD content.

To Open an Image File
Click the Open File button   , and specify the file you want to open.

To Open Special
Open an image file which was not originally scanned from ColorDesk Photo

Use Open Special to open a file which was not scanned through ColorDesk Photo and
for which you know its source, i.e. the scanner used. Select Open Special in the File
menu. In the dialog box that appears, specify under Source Device the scanner used to
create the file. If the image was originally scanned from ColorDesk Photo, open the
image using the Open command; do not use Open Special.
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Suggested Work Flow

Enhancing photos is more effective if done in a specific order. The steps below
represent the recommended work flow for performing these enhancements, however,
you may perform these steps  in any order that you find convenient. If a specific step is
not required, skip it and go to the next step. Each of the individual steps is explained
more fully in the following sections.

1. Click the Geometric
Corrections button to adjust the
image’s size and orientation.

2. Click the Dust and Scratch
Removal button to remove dust
and scratch marks.

3. Click the AutoFinish button to
automatically color correct your
image, if it does not look OK.
OR - Click the Color
Corrections button to edit the
image’s colors. You can click
the Reference Image Library
button to help you edit your
image by selecting an image for
comparison.

                                                   

4. Click the Sharpening button to
give the image a crisper look.

After editing the image, you can drag and drop it into any OLE document (such as
Microsoft Word), save it, or print it. Whatever you do, ColorDesk setup ensures the very
best color output.
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 Geometric Corrections

                                         

Resize
Click the Resize button     , and type in the new width and height in the units you
choose (inches or centimeters)
 - or drag on the resize bars which appear on the image's borders. If you check the
Keep Aspect option, the proportion of height to width in the resized image is
automatically maintained as in the original image. Check the Keep File Size option if
you want the resized file to still take up the same amount of disk space. This means
that if you change the size of the image on screen, the resolution of the printed image
will change accordingly.

Crop

Click the Crop button   . In the crop dialog box, specify the Units, and enter the new
height and width, or drag on the image to delineate the area to be saved.

Rotate Any angle

Click the Rotate Any Angle button   . In the dialog box, specify the angle of rotation,
or drag one of the horizontal or vertical grid lines to the desired rotational positions. If
you want to straighten an image, drag one of the horizontal or vertical grid line to align
it with a horizontal or vertical line of your image.

Rotate / Flip
Use the other Rotate and Flip buttons to change the orientation of your image.

Rotate 90º to the left    Rotate 90º to the right    Rotate 180º    Flip horizontally   Flip vertically 

FFFlll iiippp   VVVeeerrr ttt iiicccaaalll lllyyy

RRReeesssiiizzzeee

FFFlll iiippp
HHHooorrr iiizzzooonnn tttaaalll lllyyy

CCCrrroooppp
RRRoootttaaattteee   aaannnyyy   aaannngggllleee

RRRoootttaaattteee   999000°°° ,,,    111888000°°°
ooorrr    222777000°°° ...
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Dust & Scratch Removal

                                           

Click the Dust and Scratch Removal button. In the dialog box, select the dust or scratch
type: a Dark scratch on a light background, or a Light scratch on a dark background.
Click and drag to delineate the area surrounding the scratch. The scratch will fade into
the background.

Sharpening

                                                  

Click the Sharpening button to give the image a crisper look. In the dialog box, select
the sharpening level: Low, Medium, or High.

Auto Finish

                              

Click the AutoFinish button if you want ColorDesk Photo to automatically color correct
your image for you. A color correction toolbar appears, which displays the corrections
made and lets you do further manual color corrections. To activate this toolbar without
the automatic correction, click the Color Corrections button.
Use AutoFinish only if your original image needs correcting.
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Color Corrections

                                     

AutoFinish

Exposure
Color Balance
Contrast
Highlights

White Point

Black Point

Selective color corrections:
Hue
Intensity
Brightness

Shadow

Slider

       MultiChoice     Reset

How to use the slider
To adjust settings using the slider, click the Right and Left Arrow buttons, or click
directly on the slider to increase or decrease settings.

Exposure
To adjust exposure, click the Exposure button  , and use the slider to adjust the
amount of exposure.

Color Balance
Use Balance to adjust the overall tint of the image. When you click the Balance button,
a colorful balloon appears in the dialog box. Drag the black handle in its center to shift
color balance, or, in the image, click on the area that you wish to appear neutral (such
as gray).
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Black Point
Use Black Point to specify the darkest point in the image. After clicking the Black Point
button, use the slider - or, click on the image's darkest location to set the Black Point.

White Point
Use White Point to specify the whitest point in the image. After clicking the White Point
button, use the slider - or,  click on the image's lightest location to set the White Point.

Contrast
To adjust contrast, click the Contrast button   , and use the slider.

Highlights
To adjust the brightness of lightest portions of the image, click the Highlights button

, and use the slider.

Shadows
To adjust the amount of detail in the shaded portions of the image, click the Shadows

button   , and use the slider.

Selective Color Corrections
To correct the color attributes of an individual color or of all colors, click the Selective
Color Corrections button. A color wheel and three buttons appear: one for Hue, one for
Intensity and one for Brightness. Click inside the white  center to edit all colors - or in an
individual sector to edit that color. Then you can adjust the hue, intensity and
brightness by clicking on the appropriate button and using the slider to adjust the
settings.

Hue
Intensity
Brightness

Please refer to On-Line Help for further details.
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MultiChoice  

Use MultiChoice in conjunction with any of the ten Color Corrections tools to fine-tune
your editing. Click the MultiChoice button after selecting a color tool, for example,
Exposure. A window appears with a series of three images: the middle one shows the
current image, the left one shows the image with exposure at one level lower (-1), and
the right one shows the image with exposure at one level higher (+1). Clicking the right
or left image moves that image to the current (middle) placement, with new
corresponding (-1) and (+1) images. The working image and the tools' sliders are
updated as well.

Edit By Reference

   

What do you do if you cannot decide how your image looks best? Use ColorDesk
Photo's library of reference images. Select a reference image, and set it beside your
own image. Then adjust your image, until its color and lighting properties are similar to
the reference image. Click the Reference Image Library button.

In the drop down list, select a category
that most closely matches the kind of
image you have. Within each category,
select from among the various images.

          

It is recommended to adjust your monitor using your monitor controls until you see the
reference images at their best.



111444

Saving and Inserting

Now that you are finished editing your image, save it and insert it into your document.
You can save an image in a variety of graphic file formats, and you can save it so that it
can be correctly printed on a variety of printers.

1. Save the image, or
2. Save As, or              2  3
3. Save Special

4. Drag-and-Drop icon
5. Copy to Clipboard
6. Insert in other document                1  5  6                                                                            4

Save
If your image is already associated with a disk file, click the Save button   , to save
any changes you recently made.

Save As
Select Save As from the File menu if you want to save your image to a disk file for the
first time, or change its format, name or directory.

Save Special
Use Save Special: a. To save your file if you are going to print it on a printer not
currently connected to your computer or network. ColorDesk Photo saves the image
with the correct color data for the specified printer. You can then print the image from
any application that can handle the image. or b. To print the image from a non-OLE
application ( an application into which ColorDesk Photo images cannot be inserted).
Select Save Special from the File menu, enter the name and desired file format, and
select the printer you will use from the Destination Device drop down menu. You can
then open the image in the non-OLE application. It will print as if it was printed directly
from ColorDesk Photo.

Drag & Drop
Use drag-and-drop to embed your image in another OLE-compliant application. To
drag-and-drop an image, both ColorDesk Photo and the other application should be
visible on your computer screen. In ColorDesk Photo, press the left mouse button on
the Drag-and-Drop icon in the title bar of the image, drag the image to the other
document, and drop it at the point of insertion. Note that the shape of the cursor

indicates where you can       or cannot         drop the image.
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Regardless of how the dropped image appears on the screen, its printing colors are
matched to the image seen in ColorDesk Photo.

Copy to Clipboard

Another way to embed your image in another document is to copy it to the Clipboard,
and then paste it in the other document. Use this when you cannot use drag-and-drop,
either because its inconvenient to make both applications visible, or when the target
application does not support drag-and-drop.

In ColorDesk Photo, click the Copy to Clipboard button. Then go to another Windows
application, and paste the image into a document using the Paste Special command.

Insert Object

Some applications allow you to insert an image from ColorDesk Photo without leaving
the application. In the application, place the position indicator at the point of insertion,
and select the Insert Object command - which is in the Edit menu in Write, and in the
Insert menu in Word. In the Insert Object dialog box, select ColorDesk Photo from the
drop-down list. If ColorDesk Photo is not already running, this command will
automatically initiate ColorDesk Photo. When you view the ColorDesk Photo window,
you can open and edit an image file.

When you have the desired image, select the Exit and Return command from the
ColorDesk Photo File menu. This will return you to the other application, and embed
the ColorDesk Photo image in that application. Or, when you have the desired image,
click the Insert button in the toolbar, or select the Insert command from the ColorDesk
Photo File menu. This will embed the current image in the other application without
leaving ColorDesk Photo.

You can edit an image inserted as an object by double-clicking on the image. If you are
using Microsoft Word 6.0, the ColorDesk Photo icon appears at the toolbar. Clicking
the icon is equivalent to the Insert Object command.
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Printing

          

For best results, before printing, verify that you have specified the correct printer in
ColorDesk Setup, and that the printer driver is set according to the settings found in the
Online help under Driver Settings. If you cannot find a printer that is applicable in the
ColorDesk Setup, select “other”.

If you want to change printer setup information, select the Print Setup command in the
File menu, or click the Setup button in the Print dialog box.

To print
Click the Print button. In the Print dialog box enter the desired printing information. In
general, you can use the defaults. Click OK.

Printing an Embedded Image
When images are embedded into the document application (called container), the
images are setup to print with color matching to the printer specified at the time of
insertion. If  you will be printing on a different printer, double click the image when in
the container application. ColorDesk Photo opens. Click the ColorDesk button, and
select the desired printer. Then double click the upper left corner to close.


